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Downloading Exercise Files 
Exercise files can be downloaded from the Cheryl Price web site as follows: 
 

 
 
 
 

1 In your web browser, type: www.cherylprice.co.nz 

2 Press Enter on the keyboard to display the Cheryl Price website. 

3 Click on the Resources tab as shown at the right. 

4 Click on  Easy Way – Microsoft Word 2010   

5 

Click on the Free download hyperlink, ie   

Word 2010, Level 2    Free Download 
The File Download dialog box will display.   

6 If you have Winzip use the following instructions otherwise move to step 7. 

 a   Click on  .    

 
b   Click on the  of the  button. 

 c  If My Documents folder is not displayed click on Set default unzip folder at the bottom 
of the list.  Ensure My Documents is selected then click on Select Folder . 

 d    Click on the  of the  button and click on the My Documents folder.  The files 
will be unzipped. 

7 Click on and ensure My Documents folder is displayed.  Click on  

8 

Click on Open Folder which will display My Documents folder.  Right click on the zipped 
exercise file and select Extract All. Click on Extract.  A folder will be created containing the 
exercise files.   

You will need to double click on this folder to use the exercise files in this book. Sa
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Names of files 

Achieving Consistency Merge-Data 

Adelaide Shopping Merge-Main 

Banking Motor Homes 

Beads, Seeds and Shells Mouse 

Beauty Care Numbering 

Book Sales Numbering Exercise 

Cairns Paris in the late 19th Century 

Care of a New Puppy Planning a Wedding 

Caring for your Carpet Proofreading-test 

Cashflow Rafting 

Choosing a Cat Send-a-Basket-test 

Costello Show Jumping 

Departments Sort List 

Dining Out Sorting Assessment 

Email List Sorting Exercises 

Formats-test Suncare 

Good Food News Tables-test 

Healthcare Insurance Toastmasters 

Holland Sightseeing Toastmasters Flyer 

Italy Tour and Event 

Jury Service Triathlon 

Managing a Mortgage Xmas Gifts 

McIvers  
  
  

Sa
m

pl
e D

oc
um

en
t



vii 

 
  

Sa
m

pl
e D

oc
um

en
t



© Cherylprice.co.nz Limited  SECTION 1    1 

 
 
 
 

File Management 
Bullets and Numbering, 
Hyphenation 
Pagination 

 
 
 

 
Learning Outcomes 
 
At the end of this section you should be able to -  
 
 
 Create, use and delete folders 

 Copy, move, rename and delete files 

 Differentiate between program and document files 

 Use bullets and numbering options 

 Insert hyphens automatically and manually 

 Use pagination options 

 Achieve consistency in formatting documents 

 
 
 

  

Section 
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2    SECTION 1 © Cherylprice.co.nz Limited 

 Computer 

 Local Disk (C:) 

CD Drive (D:) 

 Windows 

 Users 

 Program Files  

 Microsoft Office 

 Your Name 

 Office14 

 Templates 

 Media 

 My Documents 

 My Pictures 

 EW Word 2010 Level 2 Exercise Files  

 Training 1on1 

Most of the Word 2010  
program files are 
located in this folder. 

Your documents are 
stored here. 

Sample templates of 
different document types. 
Templates you create are 
stored in your Users 
profile folder. 

File Management 

Folders 
In any program it is useful to set up folders so that work can be filed in separate sections - similar 
to putting documents relating to different projects in separate drawers in a filing cabinet.  
(Subfolders can be created below folders.) 

The hard disk is called C Drive which in computer language is written as C:\ (also called the Root 
or Main folder).  (If you are on a network you may be on F Drive or G Drive or on another drive.) 

The Word 2010 program files are in a subfolder called Office14 (off the Program Files \Microsoft 
Office folder).  Some program files have file extensions such as .exe, .dll, .cnv, etc.  (The file type 
can be seen by right clicking on a file and choosing Properties.) 

Your documents are usually saved in a folder called My Documents. The general structure of 
Windows 7 is displayed below.  A folder called EW Word 2010 Level 2 Exercise Files has been 
placed in the My Documents folder.  This folder contains all the exercise files you will use in this 
book. 

You will create the folder called Training 1on1 later in this section.  (If you are working on 
another drive and using another folder you will need to substitute these in this section for C Drive 
and My Documents.) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

If you are logging onto a network to use a computer the Users folder will be stored on a 
network server not on the local disk drive. 

Note 
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© Cherylprice.co.nz Limited  SECTION 1    3 

Path Names 

A path name refers to the a location of a file/or files.  A backslash (\) is used between folder names 
to clearly identify each folder.  An example of a path name would be the location of the Templates 
folder on your computer – c:\Program Files\Microsoft Office\Templates.  In Windows Explorer or 
your Open/Save As dialog box you would double click on your C drive, then double click on the 
Program Files folder, double click on the Microsoft Office folder then on the Templates folder. 
 
Templates created by you are stored in your own user profile folder at this location - 

C:\Users\Your Name\AppData\Roaming\Microsoft\Templates 
 

The Open Dialog Box 
Exercise 1 

1 Start Microsoft Word 2010.  

2 Click on  and click on . 

3 Click on the  next to  under Libraries in the Navigation pane at the left.  A list 
of folders displayed in the Documents library will appear.  Click on the  next to 

.  Double click on .  This will display all 
Word documents in the EW Word 2010 Level 2 Exercise Files folder. 

4 Click on the More Options  from the Change your view button  at the top of the 
dialog box and select . 

  

The dialog box displays: 

• The name of the active folder - currently EW Word 2010 Level 2 Exercise Files. 
• A list of files stored within the EW Word 2010 Level 2 Exercise Files folder. 
• The type of files currently selected, ie All Word Documents. 

 

Navigation  
pane 

Address bar - 
displays the 
current folder 

List of files 
stored within 
the active 
folder 

Change your 
view button 

Type of files 
displayed 

More Options 
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4    SECTION 1 © Cherylprice.co.nz Limited 

The Open and Save As dialog boxes can be resized by placing the mouse pointer at the edge 
of the dialog box; when the double arrow appears click and drag to resize.  

 

Tip 

5 Position the mouse pointer on the title bar of the Open dialog box and double click.  This will 
expand the dialog box to full screen.  With the dialog box shown at full screen you can see all 
items listed in the Navigation Pane. 

 
 
 
 

Navigation Pane 
The Navigation Pane at the left of the Open and Save As dialog boxes helps you to move around 
your computer.  Look at the options described below. 

 Microsoft Word – A shortcut to the Templates folder  

 Favorites – Shortcut links to favourite locations. 
Desktop – Displays a list of files, folders, etc on the Desktop  
Downloads – Displays a list of files downloaded from the Internet 
Recent Places – Displays a list of folders and files previously used 

 
Libraries – Libraries are a new concept introduced with Windows 7.  Libraries, 
however are not actual storage locations.  Rather, they display the contents of 
other folders, grouping similar files together.   

Documents – Displays the contents of the My Documents folder on the 
hard disk drive and other document folders assigned to the Documents 
library 

Music – Displays the contents of the My Music folder and other folders 
containing music assigned to the Music library 

Pictures – Displays the contents of the My Pictures folder and other 
folders containing pictures assigned to the Pictures library 

Videos – Displays the contents of the My Videos folder and other folders 
containing videos assigned to the Videos library 

  

Homegroup – Allows you to share files and printers across a home network. 

 
Computer – Displays your hard drive(s), CD/DVD drive and any other external 
drives (USB devices, etc). 

  

Network – Displays a list of drives and folders that can be accessed from a 
server. 

 

 
Managing Files 
Exercise 2 

1 Double click on the title bar of the Open dialog box to return it to its normal size. 

2 Use the Change your view button  to look at each of the options shown at 
the right and how these options change the display of your files.  

3 Change the view back to Details. 
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You can also use the  button to delete, copy and move selected files. 
 

Tip 

Exercises that relate to the following notes are included on page 8. 

Selecting Files 

One File Click on the file. 

Random Files Click on the first file. Hold down the Ctrl key and click on other files.  (You 
can click again on a file to deselect it.) 

Sequential Files Click on the first file. Hold down the Shift key and click on the last file to be 
selected. All files between these two files will be selected. 

Selected files can then be - 

Deleted - by pressing the Delete key. 

Copied - by right clicking and selecting Copy.  You can then change folders and select the folder 
you want to copy the files to.  Right click on a blank area in that folder and select Paste.  (If you 
are copying to a CD/DVD or USB Drive you can select the Send to option from the shortcut menu, 
instead of Copy.) 

Moved - by right clicking and selecting Cut.  You can then change folders and select the folder 
you are moving the files to.  Right click on a blank area and select Paste. 

Printed - by right clicking and selecting Print. 

  
 
 

Renaming Files 

1 In the Open dialog box right click on the file and select Rename. The name will be selected, 

eg   

2 Type a new name for the document, eg Restaurants then press Enter. 

Alterntively, click twice in the file name, type the new name and press Enter. 

Saving Files in a Different Format 
Word files can be saved in a different format, eg as a text file, template, Web Page, PDF, in Rich 
Text Format (for exporting to other programs), etc.    

1 With the file open, click on  then click on Save As. 

2 Type a file name for the document if necessary then click on the Save as type: . 

 

3 Select the file format required and click on . 

  

F2 

Ctrl C, 
Ctrl V to 

paste 

Ctrl X, 
Ctrl V to 

paste 
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Creating Folders 
1 In the Open OR Save As dialog box move to the folder or position on your hard disk drive 

where you require a new folder. 

2 Click on . 

3 Type the name of the folder in the Name box.  Press Enter. 

A folder can be deleted by right clicking on it and selecting Delete.  All files in the folder 
will also be deleted. 

 

Changing and Moving through Drives/Folders  

The Navigation Pane is used to move/change to a different folder/drive.  The following actions can 
be used in the Navigation Pane: 

 Clicking once on a drive or folder will display its contents. 

 Double clicking on a folder will display the contents of the folder 
and a list of any folders contained within under the folder name in 
the Navigation Pane.  An example is shown at the right. 

 Clicking on at the left of a folder will display the contents of the 
folder and a list of any folders contained within, under the folder 
name in the Navigation Pane, an example is shown at the right.   
Clicking on the  will turn off the display of folders listed.  

The Address bar at the top of the dialog box can be used to move up a folder or back to a previous 
location.  In the example below, files for EW Word 2010 Level 2 Exercise Files folder are 
displayed.  To move to the My Documents folder, just click on My Documents in the Address bar, 
or to display Libraries, click on Libraries.   

  

To go back to a previous location click on the Back button as shown above, eg if your last location 
was F drive it would go to that drive, not to the My Documents folder (one level up). 
 

Recycle Bin 
If you are on a network you may not be able to use the Recycle Bin. 
 

Right click on a blank area of the Taskbar and select Show the Desktop.  Double click on the 

Recycle Bin icon  on the Desktop to display all deleted files.   

Files can be restored to their original folder by selecting the file(s) and clicking on  

(you can choose [Edit] Select All to select all files, then click on  to delete all 
files.) 

Delete files from the Recycle Bin from time to time.  Remember that once files are deleted from 
here they are gone forever! 
  

Note 

Back Click here to go 
My Documents 

Note 
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Storage Locations 
Each organisation will have different policies for where electronic documents should be stored.  
Ask your supervisor or consult your policies and procedures manual to see whether documents 
should be stored in a specific folder or subfolder on the server.   

You may also find there is an organisational policy relating to the printing and storage of paper-
based documents.  Some “paperless” offices will encourage their staff to store documents solely in 
an electronic format.  Others will have a designated location for the storage of printed documents.  
Printed documents should be stored in a secure, protected location as they often contain 
commercially sensitive information. 
 

Folder Structures and File Names 

Use logical folder structures on a computer to ensure that files/documents can be located quickly 
and easily.  This allows other users to find and access files just as easily.   

An example would be to have a policy that all faxes and letters are stored in the Correspondence 
folder, monthly reports stored in the Reports folder etc.  Businesses and organisations will have 
procedures in place as to the folder structure to be used.  This information is normally found in the 
company’s policies and procedures manual. 

Most organisations have a systematic procedure for naming files, eg all correspondence may have 
the surname of the recipient, the date and the creator’s initials (smith_20-12-11_JD).  Information 
on how to name your files is usually included in the company’s policies and procedures manual. 

 

Read the scenario below and use the organisation’s policies and procedures to complete Exercise 3 
on the next page. 
 

Training One on One 

You work as an assistant for a group of computer tutors and are required to perform various tasks 
guided by the Organisational Policies and Procedures information below.  

Organisational Policies and Procedures 
 
Each student workstation has a folder containing exercise files stored in a folder called Exercise 
Files 1on1 in the default My Documents folder. 
 
Files used for testing have the word test at the end of the file name.  These need to be deleted once 
a student has completed and passed an individual course. 
 
For on-site training at a client’s location exercise files are to be copied onto a USB drive. 
 
 
 
 
 

 
 
 

Sa
m

pl
e D

oc
um

en
t



8    SECTION 1 © Cherylprice.co.nz Limited 

Exercise 3 

1 Delete the file called Formats-test. 

2 Delete random files – Tables-test, Proofreading-test, Send-a-Basket-test. 

3 Rename the file called Mouse to Using IntelliMouse and Suncare to Sun Protection. 
4 Print all the files that begin with C. 
5 Make a folder under the My Documents folder called Exercise Files 1on1. 

6 Copy the following files to the Exercise Files 1on1 folder - Italy, Jury Service, Motor 
Homes. 

7 Practise moving through folders and drives. 

8 Copy the following files to a USB Drive - Sparkling Pools, Costello, Toastmasters. 

9 Open the file called Jury Service from the Exercise Files 1on1 folder, type Training One 
on One at the end and then save the file in Rich Text Format.  Close the file. 

10 Open the file called Dining Out and save it as a Web Page.   Close the file. 

11 Delete the folder called Exercise Files 1on1 and the files within that folder. 

 

File Types 
There are different types of files stored on a computer.  
In Word 2010 documents are saved as files.  Files in 
Windows 7 can be identified in several ways in the 
Open or Save As dialog boxes – 

• the icon displayed next to a file 

• information in the Type column when Details view is selected from the Change your view 
button OR Type of file information displayed in the File Properties dialog box (right click on 
a file then select Properties)  

• the file extension (these are the letters that are added to the end of a file name, eg Word 2010 
documents have .docx added).   (By default extensions are turned off in Windows 7.) 

 
Other files you may come across when using your computer: 

Executable files (ie files that start a program) .bat, .exe    

Program files .dll, .ini   
Files with unknown file extensions   
 

 

Identifying Documents and Templates 
 
Easy Way Word 2010 Level 2 requires you to differentiate between a document and template file.  
In the following exercise you will look at where templates are stored on your computer and how 
you can identify them.  As you have learnt above documents can be identified by an icon , 
extension (.docx) and by file type shown in Details view. 
 
In Word 2010 there are three locations where templates are stored – 

• Sample templates supplied with Word 2010  
C:\Program Files\Microsoft Office\Templates\1033 

  

Icon File Extension 

 Microsoft Word Document .docx 

 Microsoft Word Template .dotx 

 Microsoft Excel Worksheet .xlsx 

 Microsoft PowerPoint Presentation .pptx 

 Microsoft Access Database .accdb 
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Placing your mouse pointer over a file in the Open or Save As dialog boxes will display the 
Type, Size and Date modified information. 

 

Tip 

• Templates you create including the Normal template (ie the “default” template that is used 
to display a blank document) 

C:\Users\Your Name\AppData\Roaming\Microsoft 

This path may vary depending on the version of Windows you have installed on 
your computer.  The above path is for a computer with Windows 7 or Windows 
Vista.  A computer with Windows XP will differ, ie C:\Documents and Settings\ 
user name\Application Data\Microsoft\Templates 

• From Word you can link to the Microsoft Templates Website -  
http://office.microsoft.com/en-au/templates  

 

Exercise 4 

  This exercise is designed for a computer with Windows 7 installed, although notes have 
been included for those running Windows Vista or Windows XP. 

1 Click on  and click on . 

2 From the Navigation Pane click on Microsoft Word (you may need to scroll up 
the Navigation Pane).  A Templates icon will display.  This is a shortcut to the 
Templates folder on your computer.  Double click on this folder. 

Windows Vista users – click on Favorite Links, and then click on Templates. 
Windows XP users – click on the Save in  and select Trusted Templates. 

 
A list of templates and folders relating to your login will appear.  There are two types of 
templates in Word 2010 – Word Templates and Word Macro-Enabled Templates.  A Word 
template is a normal template used to create simple documents.  More complex documents 
are created using a Macro-Enabled template where macros are used to create a document. 

Icon Template 

 Word Template 
 Word Macro-Enabled Template 

 
 

 

3 The location of the Templates folder is displayed on the Address bar at the top of the Open 
dialog box.  Write this path name in the space below for your own information: 
 
 
 

 

Note 

Note 
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4 From the Navigation Pane double click on  to display a list of the drives 
installed on your computer.  Double click on  (Your C drive may have a 
different name, eg OS (C).)   

5 Scroll down the list of folders shown in the Navigation Pane and double click on 

.  Scroll down and double click on . 

6 Double click on  displayed in the Navigation Pane.  Click on .  
Sample templates are displayed to the right of the dialog box. 

 

7 Position your mouse pointer on a template.  Information about the type of file, size and date 
modified is displayed, an example is shown below.  This is a quick way to see the file type. 

 

8 Click on Cancel to exit the Open dialog box. 
 

Documents are created from templates by clicking on  then , and selecting the 
appropriate template. 
 
 

 

Sample templates stored on your computer  Templates created by you 

Templates from the Microsoft website 

You will learn how to use 
and create templates on 
page 109. 
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Changing Defaults 
Default settings may have already been changed in your Word 2010 program.  If not, you can use 
the following instructions to change these. 

Font and Font Size 
You can check if the font and font size have been changed by looking at the Font box on the Home 
tab.  If it shows  then it has not been altered.  Change the default font to Arial 
11 pt as follows: 

1 Click on the Font Dialog Box Launcher  which will display the Font 
dialog box. 

2 Change the Font: to Arial and the Size: to 11 pt. 

3 Click on . 

4 Ensure the following option is selected for the font to be applied to All documents based on 
the Normal template.  

 
5 Click on OK. 

Spacing 
Click on the Page Layout tab and if 10 pt Spacing After is displayed as shown at the 
right then this has not been altered.  Remove 10 pt spacing as follows. 

1 Click on the Paragraph Dialog Box Launcher  which will display the 
Paragraph dialog box.   

2 Change the Spacing After: to 0 pt as shown at the right.  

3 Click on .  Ensure All documents based on the Normal template is 
selected then click on OK.   

Margins 
1 Click on the Page Layout tab then click on the Page Setup Dialog Box Launcher 

 which will display the Page Setup dialog box.  If margins are 
displayed as 3.17 cm change them as follows.  (If they have been changed, click on Cancel.) 

2 The Top: margin will be selected, ie .  Type:  2.54 then press the Tab 
key.  Repeat this until the margins are displayed as shown below. 

. 

3 Click on .  Click on Yes. 
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Two examples of font and font sizes are: 

This is BrushScript 16 pt font 
This is Arial 14 pt font 
 

Formatting Text 
Text is formatted when you want to change the style, 
increase/decrease the size, colour, apply special 
effects, change alignment and spacing etc. 
 

Fonts 
A font is a style of type.  Fonts can be increased or decreased in size (known as point size or pt).  
Windows has a variety of “OpenType” and “TrueType” fonts that will print with all printers (they 
have  and  next to them on the drop-down list on the Home tab).   
 
In Word it is quicker to type text, then select it and apply formatting, rather than applying formats 
as you type. 
 
To apply character formatting to a single word simply click in cursor anywhere within it and 
formatting will be applied to the whole word (ie it is not necessary to select the entire word). 
 
Once you have selected text, you can apply formatting using either – 
 

Home tab  

 
 

Font dialog box 

 

Font Font Size 

Font Size 

Font 

Click on the Font Dialog Box Launcher 
 from 

the Home tab in the Font group to 
display the Font dialog box. 

Font Dialog Box Launcher 

Grow and Shrink Font 
(increase/decrease font size) 
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